Spatial Analysis Exercise
GIS in Water Resources
Fall 2013

Prepared by David G. Tarboton and David R. Maidment

Goal

The goal of this exercise is to serve as an introduction to Spatial Analysis with ArcGIS.

Objectives

e (alculate slope from a grid digital elevation model

e Apply model builder geoprocessing capability to program a sequence of ArcGIS functions

e Use ArcGIS.com services to access and extract elevation data

e Use raster data and raster calculator functionality to calculate watershed attributes such as mean

elevation, mean annual precipitation and runoff ratio.
e Interpolate data values at points to create a spatial field to use in hydrologic calculations

Computer and Data Requirements
To carry out this exercise, you need to have a computer, which runs ArcGIS for Desktop 10.2. The

necessary data are provided in the accompanying zip file,
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2013/Ex3Data.zip

Readings

Handout on "Computation of Slope" http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2013/Slope.pdf




Part 1. Slope calculations

1.1 Hand Calculations

Given the following grid of elevations. Calculate by hand the slope and aspect (slope direction) at the grid
cell labeled A using

(1) The standard ESRI surface slope function (see lecture 7 slides 46-49 in Spatial Analysis.pptx)

(i1) The 8 direction pour point model (see lecture 7 slides 50-51 in Spatial Analysis.ppt)

This subject is also described in pp. 5-7 of the Slope handout
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2013/Slope.pdf

Refer to the slides (http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2013/Spatial Analysis.pptx) from
lecture 7 to obtain the necessary formulas for each of these methods. Refer also to the "Computation of
Slope" readings for a deeper understanding of slope.

Grid cell size 10m

47.5 48 47.7 50.6 48.3
45.1 45.8 46.8 A 48.6 47.6
45 46.1 46.4 B 47.9 47.4
45.4 46.1 47 48.6 47.7

Comment on the differences and indicate which you think is a better approximation of the direction of
water flow over the surface.

To turn in: Hand calculations of slope at point A using each of the two methods and comments on the
differences.

1.2 Verifying calculations using ArcGIS
Verify the calculations in (1.1) using ArcGIS Hydrology and Surface Toolbox functions.

Save the following to a text file 'elev.txt' (This file is also included in
http://www.neng.usu.edu/cee/faculty/dtarb/giswr/2013/Ex3Data.zip)

ncols 5

Nnrows 4

x1llcorner 0

yllcorner 0

cellsize 10

NODATA value -9999

47.5 48 47.7 50.6 48.3
45.1 45.8 46.8 48.6 47.6
45 46.1 46.4 47.9 47.4
45.4 46.1 47 48.6 47.7

This shows how raw grid data can be represented in an ASCII text format that ArcGIS can import.
Knowing how to get raw information into a form where it can be imported and analyzed using GIS is a
useful skill.

Open ArcMap and Search for Tools and find the function ASCII to Raster (Conversion)



Search +
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Specify the name of the Output raster as elev.tif and give it a disk location. (Note that the extension
specifies the grid file format, .tif for a TIFF file, .img for an ERDAS IMAGINE file, or no extension for an
ESRI GRID raster format.) Specify the Output data type as FLOAT because the given elevation data
includes decimal values.
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ﬂ ASCH to Raster

Input ASCII raster file [
C:\Jsers\dtarb\Dave \Ex3\elev. tut @
Qutput raster
C:\Jsers\dtarb\Dave\Ex3\elev. tif @
Qutput data type (optional)
FLOAT M
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You can use the identify button on the grid created to verify that the numbers correspond to the values

in the table above.

-
@) Untitled - ArcMap - Ardnfo

= El-u

4 n

Identified 1 feature

[Ee| & n < m

— " — -  — -
File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
Deds axoed A ERPE0E N
QM@ - 0 KO EIEND ST EY
Table Of Contents 1 x = ArcToolbox 1 x %
Q @ @ Bl Identify 289 Conversion Tools - %
- -8 From KML K
B £ layers 3
Identify from: I <Top-most layer> | -8 From Raster =
o @ 03
-8 From WFS
Value [=-elev —
High:111 109.000000 -8 Metadata
N & To CAD
LY
Low:106.2 Location: 25.519 l%‘.unknown Units -8 To Collada
& To Coverage
Field Value -8 To dBASE
Stretched value 179 -8y To Geodatabase
Pixel value 109.000000 & To KML

=8 To Raster
: ‘\ ASCI to Raster
-‘\ DEM to Raster
-‘\ Feature to Raster =
#., Float to Raster
-‘\ Point to Raster
‘\ Polygon to Raster
---‘\ Polyline to Raster
i Raster To Other Forn
-8 To Shapefile
8§ Data Interoperability Tools
B Data Management Tools
& Editing Tools
B Geocoding Tools
&) Geostatistical Analyst Tools ||
8§ Linear Referencing Tools
B3 Multidimension Tools
B Network Analyst Tools
B | ° Parcel Fabric Tools
2 &9 Schematics Toals <
| v ] n 3

m

12,619 43.21 Decimal Degrees

Open Customize - Extensions and verify that the Spatial Analyst function is available and checked.
This is where the spatial analyst license is accessed, so if Spatial Analyst does not appear you need to

acquire the appropriate license.




File Edit \iew Bookmarks Insert Selection Geoprocessing | Customize | Windows Help
D& x | B9 & - Toalbars N Select the extensions you want to use.
BEM@il - [N | Exensions., \ 30 Analyst
Tebls O e ax Add-In Manager.., r | ArcScan
g v \El) = Custorize Mode... aealojéitis“cal Analyst
Style Manager..,
B & Layers - Metwork Analpst
= | Archap Options.., Publisher
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Description:

Spatial Analyst 10,0
Copyright ©1993-2010 ESRI Inc. All Rights Reserved

Provides spatial analysis tools for uze with raster and feature data.

Open the tool Spatial Analyst Tools = Surface = Slope
-8 Surface
Click on the Show Help>> and Tool Help buttonto =~ i » ‘:‘F’Ed
read details on this tool. Note that when you click ,2 CE:EEE: List
on each field in the dlalgg box the help part ofthe | | %, Contour with Barriers
dialog to the right explains the content of the fileor = ., Curvature
option. Select elev.tif as the input raster and specify .. #,, CutFill
names for the output raster (e.g. Slope). Note that | . Hillshade
raster file names cannot exceed 13 characters. Set @ N Observer Points
the Output measurement to PERCENT RISEand | 7 ‘f% .

leave the Z factor at 1. Click OK.

Input raster SIDPE

| elev.if _ _
Identifies the slope (gradient, or rate of
Sl I maximum change in z-value) from each
C:\Wsers\dtarbiDaveEx3\slope cell of a raster surface.
Qutput measurement (optional)
PERCEMT_RISE

Z factor (optional)

-

Ok ] [ Cancel ] [Enuironments... ] [ << Hide Help ] Toaol Help

The resulting Slope grid should be added to the display. Use identify to verify your hand calculation for
grid cell A and note the value of slope for grid cell B.



Open the tool Spatial Analyst Tools > Surface > Aspect. Select elev.tif as the Input raster and specify

a name for the output raster (e.g. Aspect). Click OK.

Input raster

| elev.if

Output raster
C:\Users\dtarb\Dave\Ex3\aspect

-

~ e I

-:-Ehg

Aspect i

»

Denves aspect from a raster surface. The
aspect identifies the downslope direction of
the maximum rate of change in value from
each cell to its neighbors.

m

Aspect can be thought of as the slope
direction. The values of the output raster 4
will be the compass direction of the 18

] [ Cancel ] [Environments... ] [ << Hide Help ]

| ToolHep |

The resulting Aspect grid should be computed and added to the display. Use identify to verify your hand
calculation for grid cell A and note the value of aspect for grid cell B.

Open the tool Spatial Analyst Tools = Hydrology = Flow Direction

Select elev.tif as the input raster and specify names
for output rasters (e.g. FlowDir and PercDrop).
Note that the help explanation that appears when
click on the output drop raster field in the dialog
box explains that the Output drop raster is really the
slope expressed as a percentage. Click OK

=, Flow Direction

Input surface raster
| elev.if

Qutput flow direction raster
C:\Users\dtarb\Dave \Ex 3 \FlowDir

[ Force all edge cells to flow outward {optional)

Output drop raster {optional)
C:\Users\dtarb\Dave\Ex3\PercDrop

=
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Qutput drop raster (optional)
An optional output drop raster.

The drop raster shows the ratio of the
maximum change in elevation from each
cell along the direction of flow to the path
length between centers of cells, expressed
in percentages.

[ oK J [ Cancel ] ’Environments... ] l << Hide Help ]

| ToolHelp




Use the identify button on the FlowDir and PercDrop grids that are created to verify that the numbers
correspond to the values you calculated by hand and resolve or reconcile any differences. Record in a
table the ArcGIS calculated flow direction and hydrologic slope (Output drop) at grid cells A and B.

To turn in: Table giving slope, aspect, hydrologic slope and flow direction at grid cells A and B. Please
turn in a diagram or sketch that defines or indicates what each of these numbers means for the specific
values obtained for cells A and B.

1.3 Automating procedures using Modelbuilder.

Modelbuilder provides a convenient way to automate and combine together geoprocessing tools in
ArcToolbox. Here we will develop a Modelbuilder tool to automate the importing of the ASCII grid and
calculation of Slope, Aspect, Hydrologic Slope and Flow direction.

Right click on the whitespace within the ArcToolbox window and select Add Toolbox. Navigate to a
folder where you want to store your work (e.g. Ex3). In the opened window, click on the New Toolbox
icon and name it Ex3.tbx (or something else you might like). Select the new toolbox and click Open.

ArcToolbox 2 x
[§] ArcToolbox Prdd Toolbox
-8 30 Analyst Tools
- 8P Analysis Tools Lock in: [E — v] P Li:‘.l s &| e S
-8 Cartography Tools 25 Sy
+ @ConversionTools ETauDEMDinfTools ew Toolbox
18 Data Interoperability Tools W] SanMarcos.gdb
-8 Data Management Tools @E}@.tbx

1§ Editing Tools

- &P Geocoding Tools

-8 Geostatistical Analyst Tools
- Linear Referencing Tools
-89 Multidimension Tools
-8 Network Analyst Tools
-8 Parcel Fabric Tools

-8 Schematics Tools

-8 Server Tools

-8 Spatial AnaAIys.tTools Name:
- @ Spatial Statistics Tools
ol 5 | Tracking Analyst Tools Show of type:

Toolboxes

l@ Add Toolbox... ‘
%2 Environments...
[v] Hide Locked Tools

Save Settings >

Load Settings >

This is a little bit awkward, so if you have difficulties doing this, don’t worry, we did too! If you try it
over a couple of times, you should get it right.



A new toolbox should now appear in the list of tools in ArcToolbox. Right-click on the new toolbox and
select new model.

(+- %@ Conversion Tools
ArcToolbox ® ° Data Interoperability Tools
[j»° Data Management Tools
ﬁ ArcToolbox -8 Editing Tools
a 3D Analyst Tools P
. Co
B3 Analysis Tools g : Ee g . iy
é aste
&3 Cartography Tools S @ Ll % Remove
&3 Conversion Tools o @M Rename
. - P Ne
a Data Interoperability Tools w@pPs  New » | & Toolset
@ Data Management Tools El'g Se Add » (e Model..
: - ® Se| - =
i 45 Publish To ArcGIS Server
; g Tools o sp o0
-8 Sp Save As »
: eocoding Tools w @ T [Z] Item Description...
B3 Geostatistical Analyst Tools Ml Properties..
&5 Linear Referencing Tools H
. . —_ -

The model window should open. This is a window where you can drag, drop and link tools in a visual way
much like constructing a flow chart.

In the Toolbox window browse to Conversion Tools 2 To Raster > ASCII to Raster. Drag this tool
onto the model window.

Model

Model Edit Insert View Windows Help

ES AR X 0D BEEANIEKQO NS VP

Output raster




Double click on the ASCII to Raster rectangle to set this tool's inputs and outputs.

Input ASCII raster file ASCIl to Raster
C:\Users\dtarb\Scratch\Ex3'elev. bt

Qutput raster
Ci\Users\dtarb\Scratch\Ex 3'elevm. tif

Output data type (optional)
FLOAT

Converts an ASCII file representing raster data to a raster dataset.

-

][ mply || <<tiderelp | [ Toolhep

Set the Input ASCII raster file to elev.txt and Output raster to elevm.tif (I used elevm.tif so as not to
conflict with elev.tif that already exists). Set the output data type to be FLOAT. Click OK to dismiss this
dialog. Note that the model elements on the ModelBuilder palette are now colored indicating that their
inputs are complete.

“
ASCII to Raster

Locate the tool Spatial Analyst Tools > Hydrology > Flow Direction and drag it on to your window.
Your window should appear as follows.



T 00 W=

Model  Edit Inset VWiew Windows Help

B @R x9S BB AO kS P

<

ASCII to Raster

N

OQutput flow

Flow Direction direction
raster

The output from the ASCII to raster function needs to be taken as input to the Flow Direction function. To

do this use the connection tool ¢ and draw a line from elevm.tif, the Output raster of ASCII to Raster, to
the Flow Direction tool rectangle. At the dialog that pops up select Input surface raster to indicate that
elevm.tif is to be used as the input Surface raster for the Flow Direction tool.

E I
& B x o H | BREMIEN KL VP
K o

ASCIl to Raster

N

Flow Dire|

Input surface raster

Environments

Precondition
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Notice that the "output drop" oval is hollow. This is because this is an optional output that has not been
specified. Double click on the Flow Direction tool and specify names for both the Output flow direction
raster and optional Output drop raster.

) _

Input surface raster Output drop raster (optional)

I elevm.tif )
Output flow direction raster An optional output drop raster.

C:\Users\dtarb\Scratch\Ex 3 \flowdirm

The drop raster shows the ratio of the maximum change in elevation from
Force all edge cells to flow outward {optional) each cell along the direction of flow to the path length between centers of

cells, expressed in percentages.
Output drop raster (optional) - BXP P g

Ci\Users\ditarb\Scratch\Ex 3\percdropm

Click OK. Alternatively you could double click on output ovals individually to specify the output rasters.

The model is now ready to run. Run the model by clicking on the run button >

3 ~ il
o Model . E=NEEN
Model Edit Insert View Windows Help

ES SARX 9> B BT kS P

The orange boxes briefly flash red as each step is executed. The Model progress box opens and the
progress bar indicates when the model completes. You can then add the outputs to the map and examine
the results.

In the model, use the layout tool ﬂ‘ to organize the layout.
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Add the Spatial Analyst > Surface = Slope tool to your model by dragging it onto the model window.
Connect the elevm.tif output to this tool, specifying that it is the Input Raster for the Slope Tool.

Input raster |
Environments  »

Precondition

Add the Spatial Analyst > Surface = Aspect tool to your model connecting it to elevm.tif as an input in
a similar way. Double click on the Slope and aspect tool outputs and specify file names for the outputs.

When setting names you need to be careful that you do not use a name of a grid that already exists, or else
you will get a yellow warning sign in the display and the model will not run, as shown below:

utput raster
| Ci\sersidtarb\Scratch\Ex3'Slope

Double click on the Slope tool and set the Output measurement to PERCENT RISE. Your model should
appear as follows.

Model Edit  Insert View Windows Help

e +aBx/2 P BEREAROKS VP
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You can click run and do all the processing required to import the data, compute Slope, Aspect, Flow
Direction and Hydrologic Slope at the click of a button. Pretty slick!

Right click on elev.txt and select Model Parameter.

v Model Parameter
Add To Display

Right click on each of the outputs FlowDirm, percdropm, Slopem and Aspectm in turn and select Model
Parameter and Add to Display.

P

Open...

Model Parameter

Managed

| v| AddTo Display |

™
A P now appears next to these elements in the diagram indicating that they are 'parameters' of the model
that may be adjusted at run time. Close your model and click Yes at the prompt to save it. Right click on

the model in the Toolbox window to rename it something you like (e.g. FlowDirection).

Right click on the whitespace within the ArcToolbox window and select Save Settings 2 To Default

£ Add Toolbos...

.lﬂ‘ .
‘;-}Q Environments...

Hide Locked Tools

| Save Settings J To File...

Load Settings ] To Default

This saves your toolbox settings so that your system remembers the tools you have loaded (in this case the
tool you have written in Ex3.tbx). This is useful if you want to not have to hunt for this Toolbox and load
it again if you exit from ArcGIS or if there is a crash. This applies to the specific computer you are using
so on a shared lab computer it is not really necessary and will not help if next time you work in the lab you
are at a different computer or the lab computer has been "refreshed" to its clean state.

If you go back to your model and now double click on it or Open it, you’ll see that the input files are
shown as parameters of the model just like when you execute a tool in ArcToolBox.
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L'f'j' WGP vala viarigyerrnerne ruun
- @ Editing Tools

=@ B3
3:0 awDirection

@ ° Geocodin Open...
@ B Geostatist Batch...
- Linear Ref
-8 Multidim
&j° Network » Uebu
- &P Parcel Fat

- B8 Schemati @ ?o.py

Edit...

%o FlowDirection E=EET)

Click emor and wamiing icons for more information E i FlowDirection

elev. txt

Ci\Users\dtarb\scratch\Ex3\elev. txt
eﬂowdirm

C:\Users'\dtarb\Scratch\Ex 3\flowdirm
Qpercdropm (optional)

Ci\Users'\dtarb\Scratch\Ex 3 \percdropm
eslopem

C:\Users'dtarb\scratch\Ex 3\slopem
Q.Aspectrn

C:\Users'\dtarb\Scratch\Ex 3\aspectm

0 G © @

[ 0K ] ’ Cancel ] [Envircnments... ] ’ << Hide Help ] ’ Tool Help

Where you see warnings or a red X @ near one of your files, it usually either means that there is already
a file of that name in the place where you propose to put the output or there is no input file. These can be
resolved by setting the inputs and outputs correctly.

If at some point you want to go back and modify you model you should open it to Edit and make the
changes you want.
2@ ES

o o Direc
a Geccoding Tog it
Q Geostatistical A
ﬁ Linear F‘.eferenc| Edit...
& Multidimensio
£ Network Analy Edit
Q Parcel Fabric T @ Co
a Schematics Tol X Del Edits the definition of the selected

tool
ﬂ Server Tools Re

Batch...

You are done creating this model. Close ArcMap.
ModelBuilder is a very powerful way of creating complex analyses, and documenting your “workflow” in

a form that is visual and can readily be described. In this way, analyses that you’ve done can be passed on
to other analysts, and you can also use the visual palette display in your term project report or thesis to
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document how you’ve done your analysis, so the visual aspect of the display helps with documenting your
work, as well as in organizing it.

To turn in: A screen capture of your final model builder model.

We will now use this model for different data. Reopen ArcMap. Locate the file demo.asc extracted from
the zip file of data for this exercise. Double click on your FlowDirection model in the Ex3 toolbox to run
it. If you omitted to save settings to default or are on a different computer you will need to add the Ex3
toolbox by right clicking within the toolbox area, selecting Add Toolbox and navigating to where your
Ex3.tbx file is on disk. The following dialog box for the tool you created should appear when you open it.

%a FlowDirection I [F=rE )

s

- - oo = informati - - -
Click emor and waming icons for more information E FlowDirection

elev. txt
Ci\Users\dtarb\scratch\Ex3\elev. txt
Qﬂowdirm
1 C:\Users'\dtarb\Scratch\Ex 3\flowdirm
Qpercdropm (optional)
Ci\Users'\dtarb\Scratch\Ex 3 \percdropm

I eslopem

I C:\Users'dtarb\scratch\Ex 3\slopem
I Q.ﬂ\spem

| C:\Users'\dtarb\Scratch\Ex 3\aspectm

1 - i
I

I

[ 0K ] ’ Cancel ] [Envircnments... ] ’ << Hide Help ] ’ Tool Help ]

Select as input under elev.txt the file demo.asc. Specify different names for the outputs to avoid the

Q .

conflicts with existing data and remove the red crosses

F ™
B FlowDirection | [E=NEER

- -

elev, et Aspectm
C:\Users'\dtarb\Scratch\Ex 3\demo.asc
flowdirm
Ci\Users\dtarb\scratch\Ex3\demodir
percdropm {optional)
C:\Users'dtarb\Scratch\Ex 3\demopercdrop
Slopem
Ci\Users'\dtarb\Scratch\Ex 3\demoslope
Aspectm
Ci\Users\dtarb\scratch\Ex3\demoaspect

MNo description available

’ Ok ] ’ Cancel ] ’En\rironments... ] ’ << Hide Help ] ’ Tool Help ]

e — =

Then click OK and the model should run and add results for this new data to ArcMap. Examine the
ArcMap table of contents and record the minimum and maximum values associated with each of the
outputs. If you don’t see anything in your screen once this function is complete, right click on one of the
new layers produced and select “Zoom to Layer” and you’ll see the new information show up. This is
because the digital elevation model is in a new coordinate system. Here is the definition of this Demo.asc
grid as given in its first six rows:
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ncols 296

Nrows 233
xllcorner 2438224.25
yllcorner 5855081
cellsize 30

NODATA value -9999

To turn in: A table giving the minimum and maximum values of each of the four outputs Slope, Aspect,
Flow Direction, and Hydrologic Slope (Percentage drop), for the digital elevation model in demo.asc.

Congratulations, you have just built a Model Builder geoprocessing program and used it to repeat your
work for a different (and larger) dataset. If you would like to save this tool to take to another computer or
share with someone else you can copy the file Ex3.tbx from its location to a removable media to take with
you. Ifyou are going to be sharing this tool more widely there are additional steps to take to clean up the
interface (to avoid red X's), label the input fields and write help documentation for it. Close ArcMap.

Part 2. San Marcos Elevation and Precipitation.

The purpose of this part of the exercise is to calculate average watershed elevation for subwatersheds of
the San Marcos basin, and to calculate average precipitation over each of these subwatersheds using
different interpolation methods.

The following data is provided in the Ex3Data.zip file.
SanMarcos.gdb file Geodatabase.
= |3 SanMarcos.gdb
o BaseMap

(& Basin
&) Gages
[%*] PrecipStn
[E) Subwatershed

There are the following feature classes:

- Basin. The San Marcos Basin feature class from exercise 2.

- Gages. The San Marcos Gages from exercise 2 that includes Mean Annual Flow.

- PrecipStn. PrecipStn contains mean annual precipitation data from precipitation stations in and
around the San Marcos basin downloaded from NCDC following the procedures given in
http://www.ce.utexas.edu/prof/maidment/gradhydro2005/docs/ncdcdata.doc. (The NCDC website
has changed so it is no longer possible to get this data this way) This data was prepared by
downloading all years of available precipitation data for the counties in and around the San
Marcos basin, then averaging over these years, retaining only those stations with 6 or more years
of annual total data reported by NCDC.

- Subwatershed. Subwatersheds delineated to each of the stream gages used in exercise 2
following the procedures that will be learned in a future exercise.

1. Loading the Data

Open ArcMap (blank document) and from the geodatabase SanMarcos.gdb add the contents of the
BaseMap feature dataset to the map display (the Basin, Gages, PrecipStn and SubWatershed feature
classes)
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Add Data

Look in: ’-.j SanMarcos.gdb '] ® ¢
I%? BaseMap

If you right click on one this feature classes, you’ll see that this is the NAD 83 Albers map projection —
an Albers Equal Area projection using the North American Datum of 1983.

Projected Coordinate System: MAD_1983_Albers

Projection: Albers
False_Fasting: 0, 00000000
False_Morthing: 0,00000000
Central_Meridian: -96. 00000000
Standard_Parallel_1: 29, 50000000
Standard_Parallel_2: 45, 50000000
Latitude_OFf Origin: 37.50000000
Linear Unit: Meter

If you move the cursor around on the map, you’ll see that the coordinates are in meters in the
NAD 83 Albers projection coordinate system. The X-value is negative because the San Marcos Basin is
West of the Central Meridian of this projection. The Y-value is negative because the basin is below the
Latitude of Origin (and both the False Easting and False Northing are 0).

-161562.041 -879899.192 Meters

We will use this specific NAD 1983 Albers projection, which is the USA Contiguous Albers Equal Area
Conic projection, for this exercise.

Open ArcCatalog. Double Click on Add ArcGIS Server

g Add WCS Server
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At the prompt check that Use GIS services is checked and click Next

,
s N e

This wizard guides you through the process of
making & connection to an ArcGIS Server. You can
create a connection to use, publish, or administer
GIS services.

What would you like to do?

() Publish GIS services

() Administer GIS server

<k | mext> | | cancel |

Enter the Server URL http://elevation.arcgis.com/arcgis/services and your ArcGIS.com user name and
password.

,

Server URL: http://elevation.arcagis.com/arcois/services

ArcGIS Server; http:/fmyserver:6080/arcgis/services
Spatial Data Server: http://myserver:8080/arcais/rest/services

Authentication (Optional)

User Name: dtarb

Password: sRERRNES

Save Username Passwaord

About ArcGIS Server connections
About Spatial Data Server connections
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Note that your user name and password needs to have been associated with an ESRI license as arranged by
one of the instructors. Click Finish. You should see arcgis on elevation.arcgis.com displayed in your
Catalog under GIS Servers.

= HF GIS Servers

*5| Add ArcGIS Server

5 Add ArcIMS Server

| Add WCS Server

| Add WMS Server

*5 Add WMTS Server

..ﬂ arcgis on elevation.arcgis.com_443 (user) (3)

= My Hosted Services

Note that you need to attach this server every time you start ArcGIS.

Expand the tool to see what services it has available

= ._ﬂ arcgis on elevation.arcgis.com_443 (user) (3]
= EJ Tools
= E Elevation
;\% Profile
;\% SurmmarizeElevation
;\% Viewshed
= E Hydrology
‘{% Watershed
= EJ WorldElevation
@ Terrain
i MED30M

NED30 is the USGS National Elevation Dataset digital elevation model.

Drag and drop this onto your map to add this data.

= Eﬁ] GIS Servers
*E| Add ArcGIS Server
*E| Add ArcIMS Server
| Add WCS Server
| Add WS Server
HE| Add WMTS Server
= 47 arcgis on elevation.arcgis
= ] Tools
= E Elevation
. ;\\, Profile
I\% SummarizeEle
;\% Viewshed
* = E Hydrology
;\\, Watershed

= B3 WerldElevation
€ @ Terrain
mm.. | NED30m

= M}rﬁusted Services
&5 Ready-To-Use Services

m
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If you do not have access to such a service the national elevation dataset can be downloaded from the
National Map viewer, http://viewer.nationalmap.gov/viewer/, although the process is more tedious. At this
scale your map likely appears very dark as Texas is at low elevation compared to the range of elevation
data in the US. Your map should look similar to the following:

- ——
Q) Untitled - ArcMap | B

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help

De2Ea B x| o b |15 i EREEDE P A B o
REFQ@ I e -0 K@ BISMKAASL Drawing = K O~ A -2 @l W - B 1 UA-D D
Table Of Contents X
BEEEEE

= £ layers
= & PrecipStn

.
= B Subwatershed

[mm]
e asin
[}
= NED30m
Value

I High : 5605

Low : -85.6088

@e|en < 3
-178699.948 -B0B557.965 Meters

Let's export data from NED30m to have a local copy to work with. Right click on NED30m and select
Data -> Export Data

Copy

Removwve

l 5 ZoomTo Layer
##  Zoom To Source Resolution

Yisible Scale Range »
Refresh

E Open Attribute Table

Selection 3

| Data 3

Export Data...

& Save As Layer File... Export Data

i~ Create Layer Package...

M Properties..,

Exports an image from this layer
to the format of your cheoice, You
can choose to export the image of
the entire dataset, or the image in
the data frame extent.
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Set the Extent to be Data Frame, Location a convenient location on your computer and Name smdem.tif.
Click Save

Export Image Service Data - NED30m

wtent Spatial Reference
(@) Data Frame {Current)

() Image Service (Original) e
i - S @1 Service (Original
() Selected Graphics (Clipping) Clip Inside ® Image Service (Original)

Qutput Raster
[|use Renderer [T square: Cell Size (cx, cy): @ 30,92208077' 30.92208077

Force RGB Raster Size (columns, rows): () | 2135 3109

Use Colormap MoData as: -3,902823eH

MName Property

Bands 1
Pixel Depth 32 Bit
Uncompressed Size 49,67 MB

Extent (eft, top, right, bottom) (-257415.9314, -1138659.2021, -127924.9033, -1234808.4670 ~
1| i}

Location: I C:\sers\dtarb\scratch\Ex3 I
Marne: Format: |TIFF

Compression Type: MONE - l{;anpB?Sion Quality

About export raster data

After a short while the process completes. Click Yes to add the exported data to your map. You should
have a raster layer added to your ArcMap with a local subset from the NED30m DEM, that is easier to
symbolize.

Following a similar procedure add the http://landscapel.arcgis.com/arcgis/services ArcGIS service and
display NHDPIlus V2 service as you did in Exercise 2.

Server URL: http:/flandscape1.arcgis. com/arcgis/services

ArcGIS Server: http:/fmyserver:5080farcgis/services
Spatial Data Server: http://myserver:8080 farcgis rest/services

Authentication (Optional)

User Mame: dtarb

Password: seennnes
Save Username Password

About ArcGIS Server connections

About Spatial Data Server connections

< Back ][ Finish ][ Cancel
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Save your map document (Ex3.mxd) if you have not already.

2. Projecting the DEM.

It is often desirable (though not essential in this case) to work with data in consistent coordinate systems.
Let's project this DEM into the same projection as the BaseMap Feature dataset provided. Open the
Toolbox and open the tool Data Management Tools > Projections and Transformations - Raster >
Project Raster.

L g ¢ s

= &y Projections and Transformation

B Feature

= & Raster
#, Flip
;\% Mirrar

o oo

;\% Register Raster
;\% Rescale
If you find this tool hard to locate, you can Search for it also:

Search +
L | - E 7 ’Local Search

ALL Maps Data Tools

|pr|:|jec:t raster (data management) Q

Any Extent =

Search returned 10 items + Sort By =

& Raster (Toolset)
Summary: not available.
toolboxes\system toolboxes\data manag...

""E% Project Raster (Data Management) (...
Transforms the raster dataset from one ...
toolboxes\system toolboxesydata manag...

;“% Register Raster (Data Management) (...
Performs a geographic transformation to ...
toolboxes\system toolboxes\data manag...
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Set the inputs as follows:

[smdern_tif

Input Coprdinate System (optional)
| Morth_America_albvers_Foual_Area_Conic

Output Raster Dataset
C:\sers\dtarb \SoratchEx Hprojdem, if

Output Cell Size (optional)
The cell size for the new raster dataset,

The default cell size is the cell size of the
selected raster datasel.
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The Nad_ 1983 Albers projection is most easily set by clicking next to Output Coordinate System 1 and
selecting NAD 1983 Albers at the bottom in the listing of coordinate systems used in the data frame.

,

¥¥ Coordinate System | Z Coordinate System |

ﬂ’ - | Type here to search - '@' @ | @ A 'ﬂ"
SN

MADES_UTM _zone 12M
£ Geographic Coordinate Systems
£ Projected Coordinate Systerns
= laee
by Morth_America_Albers_Equal_Area_Conic
@ WG5 1984 Web_Mercator_Auxiliary_Sphere

Current coordinate system:

<UInknown
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Also set the resampling to cubic (2) and output cell size to 30 m (3). Then click on Environments. Under
Processing Extent set the Extent Same as layer Basin.

¥ Workspace Extent

¥ Qutput Coordinat
e . The Qutput Extent emdronment setting

2 Brocaasing Exter defines what features or rasters will be
processed by a tool. This setting is useful
when you nged to process only a portion of
a larger dataset. You can think of this
setting as a rectangle used to select input
Right features and rasters for processing. Any
A feature or raster that passes through the

' rectangle will be processed and written to
output. Note that the rectangle is used only
o select features, not clip them. The extent
of the output dataset will typically be larger
~] @ than the Ouiput Extent setting to account

for faatures that pass through the extent

¥ X¥ Resolution and Tolerance rectangle

Top
815678, 792862

¥ M Values
¥ Z Values

¥ Geodatabase + Defaull—The tool you are using will

determing the processing extent. All

¥ Geodatabase Advanced tools have a default extent they

¥ Fields calculate from their inputs. This
default is rarely documented in the

¥ Random Mumbers tool reference page but is usually

Options:

¥ Cartography otvious. For example, the Intersect
tool will only process features that
¥ Covernpe intersect one another, the Union tool
¥ Raster Analysis processes all features. and the Clip
tool will only process features within
¥ Raster Storage the extent of the clip features.

¥ Geostatistical Analysis % + Union of Inputs—The combinad

|| concel || <<tiderep | | Todhep |
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This will control the output to have the same extent as the Basin Feature Class. The result should appear
similar to

| @ B3 - ArcMap E=REE
D2ds B x| 0 0| b 142008 BFl=l= 1Sl kal k2 BIIEE BB - EEab
BAM@ 3« 18- 0 8 @7 B MBS0, | Dawngr kG EIO- A -2 Baw 0 B I U A-H- B e

|| Table Of Contents x| T

[ELELI-I

| B = Layers £

USA_NHDPIusV2

5 & Subwstershed
[}

= & Basin

]
Rl projdem.tif

Value
High: 618.419

Low: 734354
= O smdem.tif
Value

. High : 618.373

" Low : 64.4827

= & Precipstn
.

= O NED30m
Value
High : 5605

=

Low : -85.6088

EEIEEK c B o s 2 L = o - N !

Examine the properties of the projected dataset.

To turn in: The number of columns and rows in the projected DEM. The cell size of the projected DEM.
The minimum and maximum elevations in the projected DEM.

3. Exploring the DEM

The spatial information about the DEM can be found by right clicking on the projdem layer, then clicking
on Properties>Source. Similarly, the symbology of the DEM can be changed by right clicking on the
layer, Properties=> Symbology.
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| General | Source | Extent | Display Symbology

Show: ktretch values along a color ramp
Unique Values

Classified
Stretched
Discrete Color

Value Label
[ 618.193  High: 618.193

69.8373  Low:69.8373

cortere: [ -

Display Background Yalue: as

Use hillshade effect Z: Display MoData as

Stretch
Type: [Stmdard Deviations '] Histograms

n: 2 [1nwvert

Apply Gamma Stretch:

Ex3.mxd - ArcM.
Eile Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
OBE& L IR x 0o b 1eum i EFEROE Ry @anfDBED e - [ERekp
Bla® @i« 8-/ 8@ B MNAS DRy Dawing- kO E O A-< @ W -B 1 U A-b-Zee -
Table Of Contents rx T AT } S — 2
Eless . 2
= = layers

W USA_NHDPlusV2
Subwatershed
ol

Basin

= @ projdem.tif
Value

|y High: 618419

*Low: 734354

= B Precipstn
.

= O NED3Om

Value

High : 5605

Low: -85.6088

-154438.174 -814279 814 Meters
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To explore the highest elevation areas in your DEM select Spatial Analyst Tools > Map Algebra ->
Raster Calculator.

- &P Spatial Analyst Tools
&5 Conditicnal

& Density

&5 Distance

&5 Extraction

&5 Generalization
& Groundwater

&5 Hydrology

&5 Interpolation

. &_ Local

El & Mapﬁ;lgebra

Lo “K\.. Raster Calculator

Double click on the layer projdem with the DEM for San Marcos. Click on the “>" symbol and select a
number less than the maximum elevation. This arithmetic raster operation will select all cells with values
above the defined threshold. In the example below a threshold of 600m was used.

E=REEEES)
e e SRS L R =l

® Map Algebra expression Map Algebra expression

Layers and varia... Cenditional i The Map Algebra expression you want to

Sl P P3P .EE]. o
<>NED30M Pick

Setiull The expression is composed by specifying
the inputs, values, operators. and tools to
Math ; .
use. You can type in the expression
Abs directly or use the buttons and controls to
Exp help you create it.

“orojdem.6F > 600] + The Layers and variables list
identifies the datasets available to
use in the Map Algebra expression.
Output raster The buttons are used to enter
@ numerical values and operators into
the expression. The ( and ) buttons
can be used to apply parentheses to
the expression.

A list of commonly used tools is
mrmind A Fme anma

C:\Wsers'\dtarb\Documents\ArcGISDefault. gdbrastercalc23

-

] [ Cancel ] [En\rironments... ] [ << Hide Help ] ’ Tool Help ]

A new layer called raster appears on your map. The majority of the map (brown color in the figure below)
has a 0 value representing false (values below the threshold), and the blue region has a value of 1
representing true (elevations higher than 600 meters).
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Zoom in to the region of highest elevations and do some sampling on the smdem grid using the identify

ﬂ tool or pixel inspector & to identify the grid cell of maximum elevation. Use the draw tools to
mark your point of maximum elevation and label it with the elevation value for that pixel.

?7?

To turn in: A layout showing the location of the highest elevation value in the San Marcos DEM. Include
a scale bar and north arrow in the layout.

4. Contours and Hillshade

Contours are a useful way to visualize topography. Select Spatial Analyst Tools > Surface - Contour.
Select the inputs as follows, with a 10m contour interval:
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Input raster Contour interval

I projdem.tif

The interval, or distance, between contour

COutput polyline features lines.

C:\Users'\dtarb\Scratch\Ex3\Contours. shp

® Contour interval This can be any positive number.

Base contour (optional)

Z factor (optional)

A layer is generated with the topographic contours for San Marcos. Notice the big difference in Terrain
Relief to the west of the basin compared to the east. This results from the fact that the Balcones fault zone
runs through the middle of this basin, to the west of which lies the rolling Texas hill country and to the east
the flatter coastal plain. There is a tower located in the City of San Marcos on which you can stand and
see these differences in topography to east and west!

Another option to provide a nice visualization of topography is Hillshading.
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Select Spatial Analyst Tools - Surface - Hillshade and set the factor Z to a higher value to get a
dramatic effect and leave the other parameters at their defaults (the following hillshade is produced with a
Z factor of 10). Click OK. You should see an illuminated hillshaded view of the topography.

Input raster Hillshade

I projdem.tif

Output raster
Ci\Wsers'\dtarb\Scratch'\Ex 3thillshade

Azimuth (optional)

Creates a shaded relief from a surface
raster by considering the illumination
source angle and shadows.

Altitude {optional)

Mode! shadows (optional)

Z factor (optional)

-

| [Envirorments.... | | <<hidetelp | |

To turn in: A layout with a depiction of topography either with elevation, contour or hillshade in nice
colors. Include the streams from the NHDPlus Service and Basin and sub-watersheds from the
SanMarcos.gdb Basemap feature dataset.
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5. Zonal Average Calculations

In hydrology it is often necessary to obtain average properties over watersheds or subwatersheds. The
Zonal functions in Spatial Analyst are useful for this purpose.

Select Spatial Analyst Tools = Zonal - Zonal Statistics as Table. Set the inputs as follows:

Input raster or feature zone data Zonal Statistics as Table
ISubwatershed ;I @
Summarizes the values of a raster within
Zone field
the zones of another dataset and reports
[ HydroID -

the results to a table.
Input value raster

Iprojdem.tif ;I @
Qutput table
CiWsers'dtarb\Scratch\Ex 3'zoneelev @

Ignore MoData in calculations (optional)

Statistics type (optional)
ALL -

- -

[ QK ] [ Cancel ] [Environments... ] [ << Hide Help ] ’ Tool Help

Click OK. A table with zonal statistics is evaluated.

Table O x
zoneelev b4
Rowid | HYDROID | COUNT AREA MIN MAX RANGE MEAN 5TD UM
3 1 330 | 323069 | 290762100 134.14827 | 271.345734 | 137.197464 | 189.878595 | 25156456 61343887 892563
2 331 | 102355 | 921210300 | 244.103522 | 6168.875418 | 372.774796 | 415.5154595 | 30.452904 | 428481007.721359
3 332 | 165683 | 149114700 | 188.3143592 | 400.621338 | 212.3065946 | 283.551764 | 40.585282 47308121.893555
4 333 | 140798 | 126718200 | 173.630554 | 391.804012 | 218263458 | 2656.15186 | 43.410509 37473649 517166
5 334 | 579142 | 521227800 | 98.862326 | 214.039322 | 115.1769594 | 151.9654947 | 22.407165 B88009283.163681
6 335 | 108914 | 980227800 | 99.565163 | 410.268585 | 310.703423 | 183.531466 | 51.046411 198891828.157021
H 4 1 H E 0 out of & Selected)

This contains statistics of the value raster, in this case elevation from projdem over the zones defined by
the polygon feature class Subwatershed. The Value field in this zone table contains the HydroID from the
subwatershed layer and may be used to join these values with attributes of the Subwatershed feature class.

Right click on Subwatershed and select Joins and Relates - Join.
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o A . || | 5% Vet
O 1

Copy
CihUsers\dtarb\S) %  Remove

t
L] contours E Open Attribute Table

C:\Users\dtarb\5| Joins and Relates D ”
hillshade ',_L’ Zoom To Layer Remove Jein(s) »
Value
High : 254 [
Visible Scale Range 4 Remove Relate(s) »

Select HydrolD as the field in this layer (Subwatershed) that the join will be based on, zoneelev as the
table to join to this layer, and HydrolD again as the field in the table to base the join on.

r nl

Join Data (-2 |
Join lets you append additional data to this layer's attribute table so you can, I
for example, symbolize the layer's features using this data. I

What do you want to join to this layer?
[Joln attributes from a table V] I

1. Choose the field in this layer that the join will be based on:
HydroID

2. Choose the table to join to this layer, or load the table from disk:

[E zonceler =

Show the attribute tables of layers in this list

3. Choose the field in the table to base the join on:

porop i

Join Options

@ Keep all records

All records in the target table are shown in the resulting table.
Unmatched records will contain null values for all fields being
appended into the target table from the join table.

() Keep only matching records
If a record in the target table doesn't have a match in the join
table, that record is removed from the resulting target table.

Yalidate Join
Fosu g e

At the prompt to build an index click Yes.

B - N
Create Index ﬁ

The join field in the join table you are joining to the target is not indexed.

Would you like to automatically create an index for the join field in the join table
now? Doing so will signficantly improve performance.

[ Yes ] [ Mo J [ Cancel

[] Use my cheice and do not show this dislog again

—_— ———— e — A

It would not really matter if you clicked No as this table is sufficiently small that the presence of indices to
speed up the data queries does not make any noticeable difference.

Open the Subwatershed attribute table. Under table options select Export and specify a dBase Table and
dbf file name for the output.
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EEECHEY = )

B8 Find 8 Replace...
B  Select By Attributes..,

Export: [AJI records v]

Use the same coordinate system as:

—

this layer's source data

the data frame

B Switch Selection

m Select All the feature dataset you export the data into
(only applies if you export to a feature datasetin a geodatabase)
Add Field... Output table:

Turn All Fields On

Show Field Aliases

C:\Users\\dtarb\Scratch B3\ Export_Output|dbf

T = TP T PR T B TP TRTT

Arrange Tables AN

Restore Default Column Widths

Restore Default Field Order i [ oK ] ’ Cancel l

Joins and Relates 3 m

Related Tables 3 Lookin:  [EJExs et @ Ersae®
ilp Create Gragh...

Add Table to Layout

w Reload Cache
d——f‘ﬁ Print...
Reports r
Export...
Name: Export_Output.dbf
Save as type: [ gpASE Table v] [ Cancel ]

You do not need to add the exported dbf file to the map. The exported dbf file can be opened in Excel to
examine and present the results. Determine the mean elevation and elevation range of each subwatershed
in the SanMarcos Subwatershed feature class.

To turn in: A table giving the HydrolD, Name, mean elevation, and elevation range for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
elevation? Which subwatershed has the largest elevation range?

6. Calculation of Area Average Precipitation using Thiessen Polygons

Now to do something really useful. We will calculate the area average mean annual precipitation over the
watershed using Thiessen polygons. Thiessen polygons associate each point in a watershed with the
nearest raingage. Select the tool Analysis Tools = Proximity = Create Thiessen Polygons
—I- &l Anabysis Tools

+ 8 Extract

+ B Overlay

- 8 Prosimity

#* Buffer

Specify PrecipStn as the Input Features. Set the output feature class to be ThiessenP (saving it in the
BaseMap feature dataset) and indicate that ALL fields should be output. By saving to the BaseMap
feature dataset you ensure that the Thiessen polygon feature class inherits the spatial reference information
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from this feature dataset, keeping all your work in a consistent spatial reference. Click OK. It's really
important that you select “All” here to carry the attributes of the Precipitation stations to the polygons
associated with them.

S T P

Input Features Output Fields (optional)
I PrecipStn ;I @

& t Feature Cl . X
utput Feature Class input features will be transferred ta the
1 C:\Users\dtarb\ScratchEx 3'sanMarcos. gdb\BaseMapThiessenP @ output feature class

LI 1elds (opuonal
| m h « ONLY_FID—Only the FID field from

the input features will be transferred
to the output feature class. This is
the default.

o ALL—AIl attributes from the input
features will be transferred to the
output feature class.

Determines which attributes from the point

- -

I OK ] [ Cancel ] [Envimnments... ] [ << Hide Help ] [ Tool Help ]

The result is a Thiessen polygon feature class. This tessellates the landscape into regions that are closer to
a particular gage than to any other.

Here is what your attribute table should look like for ThiessenP. If it doesn’t have all these attributes at the
right hand end, delete the result you just computed and do it over with the ALL option selected to make
sure you transfer all the attributes from the gages to the polygons.

Table O x
H- %R X
ThiessenP X
OBJECTID * Shape * Shape_Length Shape_Area Input_FID COOPID stname latdd longdd ELEVATION | ELEM | =
» 1 ] Polygon 238567.103973 | 3100410076.503969 6| 411215 | BULVERDE 29.75 -98.45 335.3 | TPCP |:
2 | Polygon 196625.035255 2266672438.82153 27| 418187 | SEGUIN 1 S5W 29.55 | -97.966667 153.3 | TPCP |;
3 | Polygon 115197.971823 721528045 447727 15 | 413622 | GONZALES 1N 29.533333 -57.45 115.8 | TPCP
4 | Polygon 173413.86842 | 1613674567.856937 29| 418415 | SMTHVILLE 30.016667 -97.15 103.6 | TRCP
5 | Polygon 122727 252192 $94385367.281628 2| 410429 | AUSTIN-BERGSTROM INTERNATIONA 30.183333 | -57.683333 146.3 | TPCP
§ | Polygon 109158.064502 T42107271.501394 32| 4153815 | WIMBERLEY 1 NW 30 | -98.066667 253 | TPCP
7 | Polygon T7451.84458 352989955.087186 28| 418358 | SISTERDALE 29.983333 | -98.733333 4267 | TPCP
2 | Polygon 122756.03451 TBB325511.144001 kil 418877 | TEAGUE RANCH 30.433333 | -98.816667 496.8 | TPCP
9 | Polvaon 142935.29761 1276325477.645574 1 410428 | AUSTIN MUELLER MUNICIPAL AP 30.316667 | -97.766667 2008 | TPCP a
< | [ | +
44 1 % w E (0 out of 32 Selected)
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To average precipitation values in these polygons over the subwatersheds we need to intersect the thiessen
polygons with the subwatersheds and compute area weighted averages for each subwatershed. The
following calculations achieve this.

Use the search window to locate the Intersect (Analysis) tool and set the inputs as follows

- _
4 Intersect (= E |
Input Features Intersect =
Computes a geometric intersection of the
I Features Ranks input features. Features or portions of
> subnatershed features which overlap in all layers and/or

feature classes will be written to the output
feature class.

I < ThiessenP

CIIENEI|EIY Y

< n | v INPUT
Output Feature Class
Ci\Users\dtarb'\Scratch \Ex 3\5anMarcos.gdb\BaseMap\ThiessenSublntersect @
JoinAttributes (pptional)
ALL - =i
XY Tolerance (optional)
Meters V]
QOutput Type (optional)
INPUT -
INTERSECT
FEATURE
OUTPUT
[ ok || cance |[Envionments...|[ <<HideHep | | Toolhep |

Following is the result:
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If you open the ThiessenSublntersect attributed table you will see that from the 6 subwatersheds there are
now 24 polygons, each contributing to part of a subwatershed and associated with a single rain gage. Let
Py denote the precipitation associated with each rain gage and Aj the area of intersected polygon
associated with rain gage k and subwatershed i. Then the area weighted precipitation associated with each
subwatershed is

_ 2k AucPr

p, =2kl k
Yk A

Open the attribute table for ThiessenSublntersect by right clicking on the Table of Contents for it

ThiessenSublnterse -

= [ ThiessenP @ Copy
| X FERemove z
= O hillshade |E Open Attribute Table |J
Value ?
- ]
High : 254 Open Attribute Table g \
1

@ Z Open this layer's attribute table.
Shortcut: CTRL + double-click
Vi layer narne OR CTRL + T.

Low:0

= [ rastercalcdé

Add a new field to the table (named APProd)
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EH - BN Hl X Add Field -" 3 |

H Find and REP'ECE... Name: APProd
By Select By Attributes... T = -
Field Properties
B Switch Selection Alias
Allow NULL Values es
[ SelectAll Default Value
[ AddField... E |
=] Tur |
. Add Field
Sho 3
Adds a new field to the table. £ [ ok || Ccancel
Arra

Right click in the header of APProd to invoke the Field Calculator

APProd— I -

P =  Sort Ascending

=Null= = Sort Descending

<Nulk Advanced Sorting...

=Mulk=

=Null= Summarize...

=Null= Statistics...

=Mulk=

=Mulk= Field Calculator... |

=Mulk= call .

=Null= Field Calculator

=Nulk= Tus Populate or update the values of
=MNull= Fre| this field by specifying a

=Mull= calculation expression, If any of
=Null= M Del therecords in the table are
=Null= currently selected, only the values
=Mulk= H Prg of the selected records will be
=Null= calculated.

=Ml -

Click OK to the warning about calculating outside an edit session.

Create the expression [AnnPrecip_in] * [Shape_Area] and click OK.
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- —— u§1
Field Calculator
Parser
(@) VB Script (21 Python
Fields: Type: Functions:
longdd - [ (@) Mumber :gfé}}
ELEVATION _ Cos( )
ELEM () 5fring Exp ()
Nyr ) pate rc ()
AnnPredp_in {nt {{ }}
Shape_Length E S?r?{ )]
Shape_Area |= sar ()
APProd - Ten ()
< | 1 | »
[] Show Codeblock
! 4
Fo ) (=)
[
About calculating fields [ Clear ] [ Load... ] [ Save... ]
[ oK ] [ Cancel ]
L -

The result is a new field with the numerator terms for the equation above. Now locate the column
HYDROID. These are unique identifiers for each Subwatershed. Right click on the header and select
Summarize

i Hydretn d uscemm | 0 Mame
Sort Ascending

Sort Descending  TX
;l -I—K

Advanced Sorting... - Tx

| Summarize...

Stat Summarize

Fiell Create a summary table grouped |
call by thevalues in this field. The
dialog that appears lets you

Tur| choose whether all the records will
be summarized or just the

Fres selected records, |

X Delererrens E

Carefully select the summary statistics you need. I selected the following

39



SiteName

e =)

Summarize creates a new table containing one record for each unigue value
of the selected field, along with statistics summarizing any of the other fields.

1. Select a field to summarize:
HydralD

2. Choose one or more summary statistics to be included in the

output table:

[ First

[ Last
FID_Subwatershed
SitelD
SiteMName

First

[ Last
FID_ThigssenP
Input_FID
COOFID

I ——

3. Specify output table:
CUsers\dtarh\Scratch\Ex3'\SanMarcos gdbSum_Outpl @

1B EH B

Summarize on the selected records only

[ ok || cancel |

About summarzing data

Shape Area Sum

F - — i -_—
Summarize . m M

Summarize creates a new table containing one record for each unique value
of the selected field, along with statistics summarizing any of the other fields.

1. Select a field to summarize:
Subwatershed_HydrolD -

2. Choose one or more summary statistics to be included in the
output table:
Myr -
AnnPrecip_in
Shape_Length
= Shape_Area
[ Mimimum
[] Madmum
[] Average

Sum
[] Standard Deviation

[] Variance

AN d

3. Specify output table:
CAiUsersdtarbDave \Bx3SanMarcos.gdb Sum_Output @

Summarize on the selected records only

About summarizing data I OK I [ Cancel ]

= p— p— ——
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APProd Sum

r -— — E; ™
Summarize w -

Summarize creates a new table containing one record for each unique value
of the selected field, along with statistics summarizing arry of the other fields.

1. Select a field to summarize:
Subwatershed_HydrolD -

2. Choose one or more summary statistics to be included in the
output table:

Sum -
[] Standard Deviation
[ Variance

= APProd
[ Minimum
[] Maxdimum
[] Average
Sum
[] Standard Deviation
[ Variance

m. |

3. Specify output table:
CAUsersdiarh\Dave \BEx3'\SanMarcos .gdbSum_Output @

Summarize on the selected records only

About summarizing data [ OK ] [ Cancel l

b — —_—

The resulting table gives the numerator and denominator in the equation above for each subwatershed

Table
Sum_Cutput
OBJECTID * HydrolD Count_HydrolD First_SiteName Sum_Shape_Area | Sum_APProd
3 1 330 3 | Plum Ck at Lockhart, Tx 280769999 .999972 10574536624
2 331 S | Blanco Rv at Wimberley, Tx 521160000.000138 34843450746
3 332 1 | Blanco Rv nr Kyle, Tx 149159999.999968 6037428736
4 333 1 | San Marcos Rv at San Marcos, Tx 126659999 999939 5125714368
5 334 3 | Plum Ck nr Luling, Tx 521279999 999972 19037601459
] 335 7 | San Marcos Rv at Luling, Tx 9802459999.999965 | 36849504638.5

4 4 1 r M E 0 out of 6 Selected)

ThiessenSublntersect

i
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Add a field SubW_Precip_in to this table

Add Field - =5
——
Name: SubW_Precip_in
Type: Float -
Field Properties
Alias
i Allew NULL Values Yes
| Default Value
L
f [ ok [ cancel |

And use the field calculator to evaluate this as [Sum_APProd] / [Sum_Shape Area]

-
Parser
| @ VB Script ) Python
Figlds: Type: Functions:
OBJECTID " @ Number Abs ()
Ny @ A ()
ydroID - Cos{ )
® String o0s
Cnt_HydroID Exp ()
First_SiteMame # Date Fix ()
Sum_Shape_Area Int( )
Log ()
Sum_APProd sin{ )
SubW _Predip_in Sar )
Tan ()

["] show Codeblodk B B E]

SubW_Predip_in =

[Sum_APProd] / [Sum_Shape_Area] -
About calculating fields Clear ] ’ Load... l [ — ]
[ ok || cancel |

The result is the precipitation in inches for each subwatershed.
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To turn in: A table giving the HydrolD, Name, and mean precipitation by the Thiessen method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation?

7. Estimate basin average mean annual precipitation using Spatial Interpolation/Surface
fitting.

Thiessen polygons were effectively a way of defining a field based on discrete data, by associating with
each point the precipitation at the nearest gage. This is probably the simplest and least sophisticated form
of spatial interpolation. ArcGIS provides other spatial interpolation capabilities in the Interpolation
toolbox in Spatial Analyst Tools.

=|-i&f Spatial Analyst Toaols

+ % Conditional

+ % Density

+ % Distance

+ % Extraction

+ % Generalization

+ % Groundwater

+ % Hydrology

- % Interpolation
A IDw
}" Kriging
A Matural Meighbor
A Spline
2 sSpline with Barriers
A Topo to Raster
A Topo to Raster by File

A Trend

S

We will not, in this exercise, concern ourselves too much with the theory behind each of these methods.
You should however be aware that there is a lot of statistical theory on the subject of interpolation, which
is an active area of research. This theory should be considered before practical use of these methods.

Select Spatial Analyst Tools > Interpolation > Spline. Use the input points from "PrecipStn" and Z
value field as " AnnPrecip_in", and set the spline type as Tension with parameters as follows:

i “— — —-
A p a@ BESEENEINTSSEER R SRS o e
Input point features 3 Spline G

|PrecipStr1 ﬂ

Interpolates a raster surface from points

Z value field : J : i
=Ry using a two-dimensional minimum curvature
AnnPrecp_in * 2 R
spline technique.
Qutput raster
. f - i
| CilUsers\dtarbiScratch \Ex3ispline The resulting smooth surface passes !
| Output cell size (optional) exactly through the input points.
|l
100
l Spline type (optional)
TEMSION -
|| Weight (optional)
0.1
I Mumber of points {optional)
12

I oK ] [ Canicel ] ’Environments... ] [ << Hide Help ] ’ Tool Help
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The result is illustrated:

Ly

,
=

il

&
\\_ I

Select Spatial Analyst Tools > Zonal - Zonal Statistics as Table. Set the inputs as follows:

# Zonal Statistics as Table - E=EEE)

- -

Input raster or feature zone data Zonal Statistics as Table

Subwatershed 4 . . L
I _I @ Summarizes the values of a raster within the zones of

Zone field another dataset and reports the results to a table.
HydrolID -

Input value raster

I Spline ;I

Output table
I| Ci\Users\dtarb\Dave'Ex3\zonespline

lanore NoData in calculations (optional)
Statistics type (optional)

ALL -

Click OK. A table with zonal statistics is created. This contains statistics of the value raster, in this case
mean annual precipitation from Spline over the zones defined by the polygon feature class Subwatershed.

44



The HydrolD in this table may be used to join it to the attribute table for the Subwatershed feature class.
As for the elevations above this joined table can be exported and examined and presented in Excel.

To turn in: A table giving the HydrolD, Name, and mean precipitation by the Tension Spline method for
each subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest
mean precipitation using a Tension Spline interpolation?

8. Runoff Coefficients.

Runoff ratio, defined as the fraction of precipitation that becomes streamflow at a subbasin outlet is a
useful measure in quantifying the hydrology of a watershed. Mathematically runoff ratio is defined as

w=Q/P

where Q is streamflow, and P is precipitation. In this formula, P and Q need to be in consistent units such
as depth per unit area or volume. The MAflow field in the Gages point feature class gives the average
streamflow at six stream gauges in the San Marcos watershed in ft*/s. To convert these to volume units
(say ft’) they should be multiplied by the number of seconds in a year (60 x 60 x 24 x 365.25). In the
current exercise mean annual precipitation has been evaluated for each subwatershed, in inches. To
convert these to volume units (say ft°) these quantities should be multiplied by 1/12 ft in"' and multiplied
by the subwatershed area in ft*. The subwatershed feature class includes subwatershed area, in the units of
the spatial reference frame being used, which are m?. (Remember, 1 ft = 0.3048 m). The necessary
calculations are most easily performed in Excel. Use the Options/Export function to export the
subwatershed featureclass attribute table that includes your Thiessen basin average subwatershed
precipitation results to dbf format that can be read by Excel, as was done above. Similarly export the
Gages Point featureclass attribute table that includes mean annual streamflow at each monitoring point. In
Excel multiply gage streamflow by 60 x 60 x 24 x 365.25 to obtain streamflow volume, Q, in ft'. Multiply
subwatershed average precipitation (in inches) by subwatershed area (in m?)/(12 x 0.3048?) to obtain
subwatershed precipitation volume, P, in ft. On the maps you have that show subwatersheds and streams
identify the subwatersheds upstream of each gauge. Do this visually by looking at the Flowlines. Add up
the precipitation volumes over these subwatersheds then divide Q/P to obtain an estimate of runoff ratio
for the watershed upstream of each stream gage.

To turn in. A table giving runoff ratio for the watershed upstream of each stream gage.

Summary of Items to turn in:
1. Hand calculations of slope at point A using each of the two methods and comments on the differences.

2. Table giving slope, aspect, hydrologic slope and flow direction at grid cells A and B. Please turn in a
diagram or sketch that defines or indicates what each of these numbers means for the specific values
obtained for cells A and B.

3. A screen capture of your final model builder model.

4. A table giving the minimum and maximum values of each of the four outputs Slope, Aspect, Flow
Direction, and Hydrologic Slope (Percentage drop), for the digital elevation model in demo.asc.

5. The number of columns and rows in the projected DEM. The cell size of the projected DEM. The
minimum and maximum elevations in the projected DEM.
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6. A layout showing the location of the highest elevation value in the San Marcos DEM. Include a scale
bar and north arrow in the layout.

7. A layout with a depiction of topography either with elevation, contour or hillshade in nice colors.
Include the streams from the NHDPlus Service and Basin and sub-watersheds from the SanMarcos.gdb
Basemap feature dataset.

8. A table giving the HydrolD, Name, mean elevation, and elevation range for each subwatershed in the
SanMarcos Subwatershed feature class. Which subwatershed has the highest mean elevation? Which
subwatershed has the largest elevation range?

9. A table giving the HydrolD, Name, and mean precipitation by the Thiessen method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean
precipitation?

10. A table giving the HydrolD, Name, and mean precipitation by the Tension Spline method for each
subwatershed in the SanMarcos Subwatershed feature class. Which subwatershed has the highest mean

precipitation using a Tension Spline interpolation?

11. A table giving runoff ratio for the watershed upstream of each stream gage.

46



